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Introduction

Plot measured data (points) or functions (lines)

Two-dimensional plots or xy plots

e
| help graph2d J

Three-dimensional plots or xyz plots or
surface plots

.
| help graph3d ‘
N




Nomenclature xy plot Graphics
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An Example: y = sin(x)

0:0.1:52;
sin(x)
lot(x,y)
xlabel(’x?)

| ylabel(’y?)

(
| x
ly
|p
\

| title(’The sine function’)
| %title("F(\theta)=sin(\theta)’)

\
-

~ @@

Graphics

The sine function
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The autoscaling feature in MATLAB selects tick-mark spacing.
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Plotedit

Tostart plot edit mode, click

this button.

Use the Edit, Insert,

and Tools menus fo add

objedts or edit existing
objects ina graph.

Double-click on an object
to select it

Position labeks, legends,
and ofher objects by
dlicking and dragging.

Access object-specific plot
edit functions through
context-sensitive pop-up
menus.

But better to do this with lines of code, just in case you have to redo the plot.

Graphics

Use these toolbar butions to add legerd, Text, and arrows.

Fle Edt Wew Infert Took Desktop Window ge\p

=10 x|
Dedag|[hfaans & 0F =
2 OO0OmMN X" 4B
Lotka-Volterra Predator-Prey Population Model
350
300 l
Many predators; Cut
250 prey population Copy
will desline D
o
5 00 Color.
5 Line Width b
ke Line Style ¥
g 150 Marker »
o Few predators: Marker Size b
prey population
100 will increase Properties.
Show M-code

Timet (Years)



Saving Figures crephie
The plot appears in the Figure window. You can include it in your
documents:

1. type
print -dpng foo
at the command line. This command sends the current plot directly to
foo.png

~~> help print
2. from the File menu, select Save As, write the name and select file format

from Files of Types (eg, png, jpg, etc)
fig format is MATLAB format, which allows to edit

3. from the File menu, select Export Setup to control size and other
parameters

4. on Windows, copy on clipboard and paste. From Edit menu, Copy
Figure and Copy Options



Graphics

The grid and axis Commands

@ grid command to display gridlines at the tick marks corresponding to
the tick labels.
grid on to add gridlines;
grid off to stop plotting gridlines;
grid to toggle

@ axis command to override the MATLAB selections for the axis limits.
axis([xmin xmax ymin ymax]) sets the scaling for the x- and y-axes
to the minimum and maximum values indicated. Note: no separating
commas
axis square, axis equal, axis auto
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plot complex numbers

| y=0.1+0.9i, plot(y)
| z=0.1+0.9i, n=0:0.01:10,
‘plot(z.An), xlabels(’Real’), ylabel(’Imaginary’)

function plot command

| £=0(x) (cos(tan(x))-tan(sin(x)));
| fplot (£, [1 2])
\[x,y]=fplot(function,limits)

plotting polynomials
Eg, f(x) = 92% — 522 + 32 + 7 for
—2<x <5

|a=1[9,-5,3,7];
‘x = -2:0.01:5;
‘plot(x,polyval(a,x)),xlabel(’x’),ylabel(’f(x)’)

Graphics
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SU prOtS Graphics

subplot command to obtain several smaller subplots in the same figure.

subplot (m,n,p) divides the Figure window into an array of rectangular
panes with m rows and n columns and sets the pointer after the pth pane.

\x=0:o.01:5; \
| 'y = exp(-1.2%x) .*sin(10%x+5) ; \
| subplot(1,2,1) \
‘p ot(x,y),axis([0 5 -1 1]) \
| x = -6:0.01:6; \
| y = abs(x.73-100) ; ‘
| subplot(1,2,2) \
\plot(x y),axis([-6 6 0 3501) \
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Data Markers and Line Types

Three components can be specified in the string specifiers along with the
plotting command. They are:
o Line style

@ Marker symbol

@ Color

plot(x,y,u,v,’--?) % where the symbols '—— represent a dashed line

plot(x,y,’*’,x,y,%:?) % plot y versus x with asterisks connected with a dotted line
plot(x,y,’g*’,x,y,’r--") % green asterisks connected with a red dashed line

% Generate some data using the besselj

x = 0:0.2:10; ¥
yO = besselj(0,x); g
y1 = besselj(1,x); +

y2 = besselj(2,x);
y3 = besselj(3,x);
y4 = besselj(4,x);
y5 = besselj(5,x);
y6 = besselj(6,x);

plot(x, yO, ’r+’, x, y1, ’go’, x, y2, ’b¥’,
x, y3, ’cx’,
x, y4, ’ms’, x, y5, ’yd’, x, y6, ’kv’);
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Graphics

[doc LineSpec

- Solid line w Plus sign
(default) = Circle ¥ Red
e Dashed line et Asterisk Creen
et Dotted line e Point
" P Blue
- Dash-dot line * Cross
‘square’ or's’ Square c Cyan
'diamond’ or 'd' Diamond o Magenta
= Upward-pointing triangle
w Downward-pointing triangle Y Yellow
1 Right-pointing triangle k Black
= Left-pointing triangle w White
'pentagram’ or 'p'  Five-pointed star
(pentagram)
\ Cor'h 't pointed star
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Labeling Curves and Data

The legend command automatically obtains the line type used for each data
set

= 0:0.01:2;

E \ 4

|y = sinh(x); | —sinh(x)
‘ z = tanh(x); ‘ ~—-tanh(x)
| plot(x,y,x,z,’--?) ,xlabel (°x’) | 351

| ylabel (’Hyperbolic Sine and Tangent’) |

‘ legend(’sinh(x)’,’tanh(x)’) \ st j

250 1

Hyperbolic Sine and Tangent
n

05F - 4




Graphics

The hold Command and Text Annotation

| x=-1:0.01:1 \
| y1=3+exp(-x) .*sin(6*x); \
| y2=4+exp(-x) .*cos (6*x) ; \
| p1ot((0.1+0.91).~(0:0.01:10)), hold, plot(yl,y2) \
‘ gtext (’y2 versus y1’) % places in a point specified by the mouse ‘
‘ gtext (?Img(z) versus Real(x)’,’FontName’,’Times’,’Fontsize’,18) ‘

. (3+¢ sin(6r),4—e* cos{6))
Jeversus y1 N

‘ text (’Interpreter’,’latex’,... \

| ’String’,... \

- y | 2$3+e~{-xF\sin({\it 6x}),4+e {-x}\cos({\ |

s pd 1 it 6x}))$7,. .. \
‘ ’Position’, [0,6],... ‘

‘ ’FontSize’,16) ‘

C Search Text Properties in Help
. S I Search Mathematical symbols, Greek
Letter and TeX Characters
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Graphics

Axes Transformations

Instead of plot, plot with

‘ loglog(x,y) % both scales logarithmic. ‘
| semilogx(x,y) % z scale logarithmic and the y scale rectilinear. \
‘ semilogy(x,y) % y scale logarithmic and the x scale rectilinear. ‘
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Logarithmic Plots

Remember:

1. You cannot plot negative numbers on a log scale: the logarithm of a
negative number is not defined as a real number.

2. You cannot plot the number 0 on a log scale: log;, 0 = —oc.

3. The tick-mark labels on a log scale are the actual values being plotted;
they are not the logarithms of the numbers. Eg, the range of = values in
the plot before is from 10~! = 0.1 to 10 = 100.

4. Gridlines and tick marks within a decade are unevenly spaced. If 8
gridlines or tick marks occur within the decade, they correspond to
values equal to 2,3.4, ..., 8,9 times the value represented by the first

gridline or tick mark of the decade.

5. Equal distances on a log scale correspond to multiplication by the same
constant (as opposed to addition of the same constant on a rectilinear
scale).
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The effect of log-transformation

Graphics

log= " log="x' log="y' Iog= 'xy’

y =e* y =e* y=e* y =€

log=" log="x' log="y' Iog= "xy’

y=x° y=x* = y =X

log= " log="x' log="y' Iog= 'xy’
y =l y =log x =16g X y =l
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Specialized plot commands

Command Description

bar(x,y) Creates a bar chart of y versus x

stairs(x,y) Produces a stairs plot of y versus x.

stem(x,y) Produces a stem plot of y versus x.

,-.ullll‘“|||‘|llllu._ ‘

Graphics
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Graphics

Command Description

plotyy(x1l,y1,x2,y2) Produces a plot with two y-axes, yl on
the left and y2 on the right

polar(theta,r,’type’) Produces a polar plot from the polar co-
ordinates theta and r, using the line type,
data marker, and colors specified in the
string type.

Multiple Dacay Rates

Fast Decay




Scatter Plots Graphics

‘ load count.dat \
| scatter(count(:,1),count(:,2), |
‘ dy%d) ‘
‘ xlabel (’Number of Cars on ‘
\ Street A’); |
| ylabel (’Number of Cars on |
\ Street B’); \

Murnber of Cars on Street B

s0r-

L L L )
0 20 an 60 a0 100 120
Mumber of Cars on Street &
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Error Bar Plots

load count.dat;

y = mean(count,2);

e = std(count,1,2);
f

Graphics

2001
150

100

I 1T
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Splines

Add interpolation

p
| x=1:24

\ y=count (:,2)
| xx=0:.25:24
‘ yy=spline(x,y,xx)

‘ plot(x,y,’0?,xx,yy)
AN

Graphics

24



Outline

1. Graphics

3D Plots

Graphics
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Graphics

Three-Dimensional Line Plots

—0.05t

Plot in 3D the curve: . = ¢ sin(t),y = e %% cos(t),z =t

|t = 0:pi/50:10%pi;
‘ plot3(exp(-0.05%t) .*sin(t), exp(-0.05%t).*cos(t), t)
‘xlabel(’x’), ylabel(’y’), zlabel(’z’), grid

26



Graphics

Surface Plots

Surface plot of the function z = ze 1=y 4% for —2 < 2 < 2 and
—2 <y < 2 with a spacing of 0.1

‘ [X,Y] = meshgrid(-2:0.1:2);
| Z = X.*exp(-((X-Y."2).72+Y."2));
‘mesh(X,Y,Z), xlabel(’x’), ylabel(’y’), zlabel(’z’) % or also surf
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Graphics

Contour Plots

Contour plot of the function z = xe*[(w*i‘IZ)Z“/Z], for =2 <2 <2 and
—2 <y < 2 with a spacing of 0.1

‘ [X,Y] = meshgrid(-2:0.1:2);
| Z = X.*exp(-((X-Y."2).72+Y."2));
‘contour(X,Y,Z), xlabel(’x’), ylabel(’y’)

05[

05
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Three-Dimensional Plotting Functions

Function
contour(x,y,z)
mesh(x,y,z)
meshc(x,y,2)

meshz(x,y,z)

surf (x,y,z)
surfc(x,y,2z)

[X,Y] = meshgrid(x,y)

[X,Y] = meshgrid(x)
waterfall(x,y,z)

Graphics

Description

Creates a contour plot.

Creates a 3D mesh surface plot.

Same as mesh but draws contours under
the surface.

Same as mesh but draws vertical refer-
ence lines under the surface.

Creates a shaded 3D mesh surface plot.
Same as surf but draws contours under
the surface.

Creates the matrices X and Y from the
vectors x and y to define a rectangular
grid.

Same as [X,Y]= meshgrid(x,x).
Same as mesh but draws mesh lines in
one direction only.
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Graphics

a) mesh, b) meshc, c¢) meshz, d) waterfall
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Graphics

Vector fields

Use quiver to display an arrow at each data point in 2 and y such that the
arrow direction and length represent the corresponding values of the vectors u

and v.
4,,_;////4 / f \ [x,y] = meshgrid(0:0.2:2,0:0.2:2);
e A A u = cos(x).*y;

L] S S Y v = sin(x).*y;
) A A S B S figure
R A A A B quiver(x,y,u,v)
T ’ 4 \
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Graphics

Guidelines for Making Plots

@ Should the experimental setup from the exploratory phase be redesigned to
increase conciseness or accuracy?

@ What parameters should be varied? What variables should be measured?
@ Should a 3D-plot be replaced by collections of 2D-curves?

@ Can we reduce the number of curves to be displayed?

@ How many figures are needed?

@ Should the x-axis be transformed to magnify interesting subranges?

@ Should the x-axis have a logarithmic scale? If so, do the x-values used for
measuring have the same basis as the tick marks?
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Make sure that each axis is labeled with the name of the quantity being
plotted and its units.

Make tick marks regularly paced and easy to interpret and interpolate,
eg, 0.2, 0.4, rather than 0.23, 0.46

Use the same scale limits and tick spacing on each plot if you need to
compare information on more than one plot.

Is the range of x-values adequate?

Do we have measurements for the right x-values, i.e., nowhere too dense
or too sparse?

Should the y-axis be transformed to make the interesting part of the
data more visible?

Should the y-axis have a logarithmic scale?

Is it misleading to start the y-range at the smallest measured value?
(if not too much space wasted start from 0)

Clip the range of y-values to exclude useless parts of curves?



Graphics

Can we use banking to 45°7
Are all curves sufficiently well separated?
Can noise be reduced using more accurate measurements?

Are error bars needed? If so, what should they indicate? Remember that
measurement errors are usually not random variables.

Connect points belonging to the same curve.

Only use splines for connecting points if interpolation is sensible.
Do not connect points belonging to unrelated owners.

Use different point and line styles for different curves.

Use the same styles for corresponding curves in different graphs.

Place labels defining point and line styles in the right order and without
concealing the curves.
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Graphics

Captions should make figures self contained.

Give enough information to make experiments reproducible.
Golden ratio rule: make the graph wider than higher [Tufte 1983].
Rule of 7: show at most 7 curves (omit those clearly irrelevant).

Avoid: explaining axes, connecting unrelated points by lines, cryptic
abbreviations, microscopic lettering, pie charts
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